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[vadas

Sios metodinés priemonés — paskaity konspekto tikslas yra supazindinti su pristatymy
(pateik¢iu) kiirimo programa Microsoft PowerPoint, iSmokyti palaipsniui ivaldyti ja. Paskaity
konspektas skirtas klausytojams, kurie jau Siek tiek jvalde¢ kompiuteri, t.y. orientuojasi Windows
aplinkoje bei yra dirbg su tekstiniu redaktoriumi Word.

Klausytojai, ivaldg Sia programa, mokeés kurti pristatymus konferencijoms, praneSimams,
iterpdami grafinius objektus i§ kompiuterio atminties, Internet’o arba kurdami naujus.

Didziaja Sios priemonés dali sudaro metodiskas pristatymo kiirimo apraSymas, naudojant
ivairias priemones. 15 ir 16 skyriuose pateikta pagrindiniy irankiy reikSmiy santrauka. 17 skyriuje
pateikta nuosekli pristatymo kiirimo sutrumpinta atmintiné. Pabaigoje 1 priede pateiktas vienas i$
galimy pristatymo pavyzdziy. 2 priede - praktiné uzduotis, kurig kiirybiskai atlikus bus itvirtinti
darbo su MS PowerPoint igudziai.

Pateikta medziaga suteikia Zymia metoding parama ne tik praktiniy uzsiémimy metu su
déstytoju, bet ir mokantis dirbti kompiuteriu savarankiskai.

Tikiuosi, kad §i priemoné padés Jums pazinti dar viena idomia kompiuterio panaudojimo

srit] ir padés apibendrinti iki Siol igytas zinias.

Pagarbiai Fausta Melninkiené



Microsoft PowerPoint 2000 paskirtis

Microsoft PowerPoint 2000 — prane$imy rengimo programing iranga, kuria patogu naudoti
norint greitai parengti vaizdy, informatyvy praneSima moksline, profesine ar kasdiene tema:
patogiai pateikti naujus jvairios paskirties gaminiy ar produkty gamybos metodus ar biidus, skelbti
naujienas, reklamuoti prekes ar paslaugas, iSdéstyti moksliniy tyrimy rezultatus, pasirengti
kvalifikacinei atestacijai, skaityti paskaitas, ginti bakalauro, magistro darbus ar daktaro disertacijas,.
PraneSimo s¢kmeé ir pateikiamos informacijos poveikis klausytojams tiesiogiai priklauso nuo
informacijos paruoSimo kokybés. Profesionaliai ir greitai pateikti informacija padeda tam tikslui
skirta praneSimy rengimo programingé jranga, integruojanti tradicinius ir originalius duomenis, kurie
pateikiami skaidrése tekstu, lentele, pieSiniais, grafikais, vaizdais, garsais animacija. Naudojamos
efektingos vaizdinés priemonés, kurios ne tik papuosia, pagyvina praneSima, sudomina klausytoja,
bet ir padeda jam lengviau {siminti pateikiama informacija. PraneSimy rengimo programiné jranga
labai paranki vartotojui. Ji lengvai ir greitai isisavinama, kadangi turi daug efektyviy pagalbos
priemoniy: asistenta patar¢ja, kuriuo vadovaujantis nesudétinga kurti praneSima pasirenkant
praneSimo modeli Sablona, kuriame tereikia uzpildyti jau paruoStus laukus tekstu, lentelémis
grafikais, paveiksléliais, parinkti, pagalbines priemones, palengvinancias prane$imo pateikima,
pavyzdziui, jvairius mygtukus, suteikiancius galimybg patogiai ir greitai judéti nuo vienos skaidrés
prie kitos ar iSsikviesti reikiama informacija Internete. Microsoft Windows 2000 operacinés
sistemos aplinkoje tikslingiausia praneSimus rengti Microsoft kompanijos produktu Microsoft
PowerPoint 2000, ieinanciu | Microsoft Office 2000 paketa. Kadangi kompanija Microsoft yra gerai
18sprendusi savo produkty suderinamumo problema, tai Microsoft Word, Microsoft Excel, Microsoft
Access sukurtus dokumentus lengva ir patogu integruoti i Microsoft PowerPoint 2000 skaidres. Jei
vartotojui daznai tenka ruoSti praneSimus, tai igijes pakankamai patirties jis paprastai rengia
praneSima visai tuS¢iame praneSimo modelyje-Sablone laisvai kurdamas ir iSdéstydamas teksta bei
kitus reikalingus objektus, panaudodamas praneSimo rengimo programingje irangoje esancias
pagalbines priemones, kad realizuoty savo sumanymus.

1. Microsoft PowerPoint 2000 iSkvietimas.

Programa iSkvieciama dirbti vienu i§ operacinés sistemos Microsoft Windows 2000
aplinkai jprasty budu:

e Start/ Programs/Microsoft PowerPoint 2000,

e Microsoft Windows 2000 darbo lauke spustelé¢jus Microsoft PowerPoint 2000
paveikslélj.

ISkvietus programa i Microsoft PowerPoint 2000 darbo lauka, displéjaus ekrane pasirodo
dialogo langas, kuriame pateikiamos trys prane$imo rinkimo galimybés:

PowerPoint H
—iCreate a new presentation using

= AutoContent Wizard

™ EBlank presentation

% i Open an exisking presentation

Mare Files. .. -
\FaustaifkolegijalDEYS prist

‘LukasiMano priskakymas

\TEMPpriskatymas

\TEMP{ Tolimiau =l

™ Don't show this dialog box again

Cancel |




I - naudojant asistenta-patar¢ja;
I - naudojant prane$imo modeli-Sablong;
" Blank presentation I - tugéiame lape~
Dialogo lange pazyméjus pozicija ‘ @ " Qpen an siisting presentation ‘ | , galima iSkviesti
ankscCiau sukurtus praneSimus, jei tokie jau buvo parengti,

naudojant dialogo lange Zemiau esancia slinkimo juosta, juos perziuréti, jei reikia — papildomai
redaguoti.

2. AutoContent Wizard asistentas-pataréjas.

Pasirinkus galimybe ‘ (B € aoconeen s ” , iSkvieCiamas dialogo langas,
kuriame galima pasirinkti sumanyta praneSima geriausiai atitinkantj tipa. AutoConten Wizard
pateikia idéju, pavyzdziu kuriant norima prezentacijos varianta, atitinkanti tam tikrus reikalavimus

bei normas. pucConenwizad R

The AutoZontent Wizard gets yvou started by
providing ideas and an organization Far your
presentation,

Finish

Cancel | <= Bt |,

2|

Spusteléjus pele pozicija Presentation Type arba mygtuka <Next>, dialogo lango kortelése
atveriami visi pagal tematika galimi praneSimuy tipai:

AutoContent Wizard - [Generic]

Select the type of presentation vou're going to give

Al

Recommending a Strategy
General Communicating Bad Mews
Training
Corporate Brainstarming Session
— |Certificate

Projects

Sales [ Marketing

Carnegie Coach

Aadd. .. | R_emnval

Finish |

Cancel | < Back |

Pasirinkti prezentacijos tipa: strateging, produkty perdavimo, mokymo ir t.t. prezentacija.
Po to nuspaudus mygtuka <Next> arba parinkus pozicija Presentation style pateikiamos rengiamo

pranesimo rodymo galimybes: oy e - 1

What bype of output will you use?

i+ On-screen presentation
" Web presentation

" Black and white overheads
" Color overheads

" 35mm slides
Finish

Cancel < Back Mext = Finish |




e On-screen presentation — pristatymas bus pateikiamas kompiuteriu arba i§ kompiuterio
projektorium rodoma ekrane;
Web presentation — bus publikuojama Internete;
Black and white overheads — juodai baltos skaidrés;
Color overheads — spalvotos skaidrés;
35 mm slides — 35 mm foto skaidreés
Spusteléjus mygtuka <Next> arba parinkus pozicija Presentation options, atveriamas
dialogo langas, kuriame galime pradéti kurti praneSima, uzrasant jo pavadinima (Presentation
Title), antrastg apacioje (Footer), nurodant, kad buty pateikiama prane§imo rengimo ar redagavimo
data (Date last update) ir skaidriy numeriai (Slide numbers). Siame etape prane$ama, kad
prezentacijos Sablonas su reikalinga informacija jau yra paruostas. Spausti mygtuka <Finish> ir
ekrane pasirodys sukurtas formos modelis-Sablonas, kuriame galime iSskirti tris atskiras skaidrés
dalis:
e skaidrés sritis. Joje jvedamas praneSimo tekstas, kuris bus matomas skaidréje ir jis,
redaguojamas Sioje srityje, kis ir skaidres srityje,
e maketo sritis. Joje matomas ir { visas kuriamas skaidres jvedamas tekstas, kuris
redaguojamas Sioje srityje, kis ir skaidrés srityje,
e pastaby sritis. Joje galima jvesti svarbius ruoSiamai skaidrei skirtus praneSimo akcentus,
kurie palengvina pranesimo pateikima.
Minétos trys skaidrés dalys aiSkiai matomos Microsoft PowerPoint 2000 darbo rezimu
Normal View kuriamo praneSimo “Informatikos samprata” pateiktame pavyzdyje:

Microzsoft PowerPoint - [Prezentationl]

J Eil= Edit “iew Insert Format Tools Slide Show  Window Help =& =]
NDEeEHs @ | ta2|Rad - | apmm s @
JE‘H' - | B r o = ”_E = |i= = |A_ & | =4 ”E Common Tasks el
J  1pt |- g |Tab|e-| @”_E[];[_

@mu raida
+ Kormpiuteriy kartos
« Kormpiuteriy klases
3 2 Tretioji paskaita —
« Informacing valdymo
sistema
+ Informacine sisterma
+ Kompiuterine sistema

A
m=eee k] | v |Cllck o add notes =
J Diraw IE(: | Autoshapes ~ ™~ w [ [ [E] (B | S - ; A . = = =
= N=NE - aR |e'%if- 96|ir?-‘£"?£' <
| Cutline | / Generl rw o
Maketo sritis Skaidrés J \_ Pastaby sritis

sritis




3. PraneSimo rengimas naudojant modelj-Sablona Design Template.

Microsoft PowerPoint 2000 galimybiy dialogo lange parinkitei ®© Design Template ir
spustelékite mygtuka OK. Atveriamas New Presentation dialogo langas:

Mew Presentation B |

General Design Templates IF‘resentetiens I Office 97 Templates I

Expeu:litien Netwerk Blitz I
Fectery Netel:ueek

FireI:ueII F‘est Modern e
Gesture F‘ulse

E!_l Global E!_l Radar

High YWoltage E!_l Ribbons

Japanese Waves Rin:epeper

Le'-.-'erne Remenesque "o .
Lu:u:k and Key Sekure

Merl:ule Sendstene

Meuntein Seering

Nature Streight Edge

E!_l MNean Frame Stretegic

| i

K Cancel

Kortelése:

General — pateikiami tokie pat praneSimy modeliai- Sablonai, kaip ir AutoContent Wizard,
bei galimybé¢ praneSima kurti tus¢iame lape;

Design template — pateiktama skaidriy spalvy gama, o teksta reikia iSdéstyti jau paciam
praneSimo rengéjui;

Presentations — pateikiami tokie pat praneSimy modeliai, kaip ir AutoContent Wizard,
taciau galima pasirinkti skaidriy spalvy gama, bet naudoti standartinj teksto iSdéstyma.
Parinkite jums patikusj pranes§imo modelio-§ablono tipa.
Microsoft PowerPoint 2000 dialogo lange New Presentation galima patogiai perziiiréti visus
siilomus profesionalius praneSimy modelius-Sablonu, nes matoma ir ju forma.
Dialogo lange pazymékite patikusi prane§imo modelj-Sablona. Pavyzdyje pasirinkta kortel¢ Design-
Templates ir praneSimo modelis-Sablonas 7opo. Paspaudus mygtuka OK, atveriamas dialogo
langas New Slide. Jame sitiloma pasirinkti viena i§ Choose an AutoLayout skaidriy formy, i kuria
galima integruoti ir teksta, ir lentelg, ir grafika, ir pieSini, ar jvesti tik pavadinima, ar palikti visai
tuscia. Microsoft PowerPoint 2000 suteikia praneSimo rengéjui galimybg ne tik integruoti | skaidrg
tvairius duomenis kaip atskirus objektus, bet ir integruotus dokumentus ikelti kaip atskira objekta.
Tai labai patogu ruoSiant pranesima i integruoty dokumenty-darby, kuriuos tereikia ikelti i skaidre
suteikus jai prasminga pavadinima.

4. Naujo pranesimo kiirimas

Pasirenkus Blank Presentation. , kuriamas naujas pristatymas.
Atsiveria dialogo langas. Jame parinkite skaidrés forma, kurioje yra pavadinimui ir tekstui skirta
vieta.



Pazymeékite pasirinkta forma:

New Slide |

Choose an Aubolayout:
N - Zancel |
anlE= | |lsBel | (lal0al]
— — — Bulleted List
B
El
[~ Don't show this dialog box again

Spusteléjus pele mygtuka OK, atveriamas Microsoft PowerPoint 2000 darbo laukas. Jame
iSrySkintos trys skaidrés sritys arba Microsoft PowerPoint 2000 lango dalys, kuriose patogu rengti
pranesima New Slide lange pasirinktos formos skaidréje:

[€] Microzoft PowerPoint M= E3
JE“E Edit Wiew Insert Format Tools Slide Show Window Help

Dﬁ’rﬂ|§i§°|éﬁﬁ:§ KD v Cuw %;{5|@ »

1o add ti

| Click to add notes ﬁ
JD[anIE|.ﬁ.gtDShapesv\\ \G|ﬂ*-ﬁ'E_E -
==l e I E R L

| Slide 2 of 2 | Topo I'E_ o

Maketo srityje matomas kvadratélis, pazymétas numeriu 1 — tai pirmoji rengiamo
pranes$imo skaidré, kuriai suteikiamas pavadinimas, kai redaguojama maketo arba skaidrés srityje.

Skaidrés srityje pazymétoje eilutéje Click to add title ivedamas skaidrés pavadinimas,
zemiau esancioje eiluteje Click to add text — tekstas, kur] norime pamatyti skaidr¢je. Jei norima

teksta pradéti vis nauja eilute, tai kiekviena karta spustelimas klavisas ENTER. Pastaby srityje
ivedamos pranes¢jui reikalingos pastabos.



5. Skaidriy parametry nustatymas

File->Page Setup — nustatomi skaidriy dydZiai ir orientacija.
o On- screen Show — rodyti ekrane;
o A4 Paper — A4 formatas (210x297 mm);
o 35 mm Slides — 35 mm skaidré;
o Custom — nustatomi savi parametrai:
=  Width (plotis) — nurodomas skaidrés plotis centimetrais;
= Height (aukstis) — nurodomas skaidrés plotis aukstis Cm;
= Qrientation — Portrait/Landscape — vertikaluslapas/horizontalus lapas.

6. PraneSimo rengimo ciklas

Pavadinimo suteikimas.

Teksto jvedimas.

Papildomo teksto jvedimas.

Teksto suzyméjimas specialiaisiais simboliais.
Paveiksléliy jkélimas.

Antras¢iy jvedimas.

Datos jvedimas ir atnaujinimas.

Skaidriy numeravimas.

. Animacijos suteikimas.

10. Valdymo mygtuky suteikimas.

11. Susiejimas su Interneto WWW dokumentais.
12. Visy skaidriy spausdinimas viename puslapyje.

r 1
Kurdami dokumenta ir po kiekvienos redakcijos nepamirSkite iSsaugoti ji Microsoft
Windaws 2000 aplinkai jprastu buidu.

00N U AW~

Microsoft PowerPoint 2000 rengiama praneSima galima tvarkyti, redaguoti ir matyti displ¢jaus
ekrane toliau pateikiamais reZimais $iais biidais:
o mygtukais,

-

Normal Outline Slide View Slide Sorter Slide Show
View View

o meniu View/Normal View/Outline View/Slide View/Slide Sorter/Slide Show, kur:

Normal View [g - matomas Microsofi PowerPoint 2000 darbo laukas, suskirstytas { tris sritis,
kuriose galima rengti praneSima,

Outline View = - didziausia ekrano dali uzimanti maketo sritis, kurioje patogu tvarkyti praneSimo
struktiira,

Slide View [7] - skaidrés sritis, skirta jvesti teksta, grafikus, filmukus, animacija, garsus,
hipernuorodas 1 kitus dokumentus, tarp ju ir WWW,

Slide Sorter =g - vienu metu ekrane galima matyti iki 12 skaidriu, todél patogu pertvarkyti ju
18déstyma, t. y-Sukeisti vietomis,



Slide Show (&t | - praneSimo perziliros rézimas.

6.1. Pavadinimo suteikimas skaidrei

Suteikite pasirinktos formos skaidrei pavadinima. Skaidrés srityje iSskiriamos dvi dalys:
skaidrés pavadinimo ir pagrindinio teksto-objekto. Skaidrés pavadinima patogu jvesti skaidrés
srities pavadinimo dalyje punktyru apvestame kvadratélyje spusteléjus pele atsiranda Zymeklis ir
esant] teksta Click to add title pakei¢iant norimu. Lygiai taip pat punktyru apvestame kvadratélyje
Click to add text esant] teksta kei¢iame skaidrés turinio tekstu. Tam reikia spusteléti pele ant esamo
teksto — atsiranda rémelis, o jame — zymeklis. Tada ir iveskite skaidrés pavadinima, pavyzdziui,
Informatikos laboratoriniai darbai, ar norima skaidrés teksta. Automatiskai toks pavadinimas
ivedamas ir matomas maketo srityje prie skaidrés kvadratélio, pazyméto skaidrés numeriu. Kaip jau
minéta, skaidrés srityje redaguojamas tekstas kinta ir maketo srityje ir atvirksciai.

PraneSimo teksto formatas visose trijose Microsoft PowerPoint 2000 darbo lauko srityse

tvarkomas tokiais pat biidais, kaip ir tekstiniu procesoriumi.

6.2. Teksto jvedimas

Pasirinktoje skaidrés formoje spustelé¢jus pele ant esamo skaidréje teksto atsiranda
zymeklis. Toje vietoje jvedamas naujas tekstas.

Pasirinkta skaidrés forma galima pakeisti dviem biidais:
o meniu Fomat/Slide Layout...,
O kontekstiniu meniu/Slide Layout... .

PraneSimui apie atliktus darbus rengti pasirinkite skaidrés forma, kurioje yra jos
pavadinimas ir skaidrés turinio pradzia, kad biity patogu ikelti jau sukurtus integruotus dokumentus-
darbus.

6.3. Papildomo teksto jvedimas

Ivesti 1 skaidre papildoma teksta galima kaip jau buvo aprasyta, ivedant { kvadratéli Click
to add text arba galima panaudoti ir teksto dézute vienu ir budu:

o mygtuku, kuris yra mygtuky juostoje Drawing,
o meniu Insert/Text box.

Sis biudas naudojamas tada, kai skaidrés forma pasirenkama tik su vieta,
skirta pavadinimui. Spusteléjus pele, norimoje skaidrés srities vietoje atsiranda mazutis teksto
dezutés rémelis. Teksto dézuté padidinama spusteléjus pele dézutés rémelio kamputi ir atsiradusia
dviguba rodykléle traukiant rémeli iki norimo dydzio. Atleidus pelés mygtuka, teksto dézutéje
atsiranda Zymeklis. Ten ir iveskite, redaguokite norima teksta. Tokiu btidu sukurkite tiek teksto
dézuciy, kiek norite jvesti teksto eiluciy arba viska iveskite vienoje teksto dézutéje ir norimas teksto
dalis atskirkite spusteléj¢ Enter — jveskite visy norimy punkty pavadinimus, kuriuos pateiksite
praneSime. Kad nereikéty kiekvienai teksto eilutei kurti naujos teksto dézutés, galima kopijuoti |
norima vieta skaidrés srityje iprastu kopijavimo biidu arba i§ karto i visas numatytas vietas skaidrés
srityje paspaudus klavisa Shift.

12
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Pateikite praneSimo apie atominés elektrinés informacinj centra pirmaja skaidre.

Kurkite pagal pateikta Zemiau pavyzdi: Cia pateiktas pirmosios skaidrés pavyzdys,

matomas rezimu Normal View.

[E Microsoft PowerPoint - [Presentation] __________________________________ HEE
J File Edit Wiew Insert Format Tools Slide Show ‘Window Help == =]
a8y i2a<s oo |@@EOmaEas - @ 2
J'-.-'eru:lana I l?f o = |§|§E i= = |AT A | o Hg Common Tasks = 2
JJQ|—'1D'I '£|'£7|Tgbh3v @”EE[];[_

1 3D mformaciios centre =
pamatysite:

+ veikiantj IAE bloko
makets;

kuro rinkles make
paﬂa%brandutjin veikiant] IAE bloko makets;

kuro saugojimo kuro rinkles maketg,

konteinerio CASTOR panaudoto branduolinio kuro saugaojimao
makets,

videcfilmus apie 1AE,
Lietuwos energetik g,

konteinerio CASTOR makety

videofilmus apie IAE, Lietuvos energetika,
uZsienio AE, Yisagino miests;

tiesiogin| waizdg i% bloky valdymo pulto,

uZsienio AE, Yisagino reaktariaus patalpos, turhing sales ir
miests; panaudoto kuro islaikymo baseino;
+ tiesioginj vaizds iE blol kompiutering informavimo programa,
valdymo pulto,
reaktoriaus patalpos,
E‘ﬂ:'ln'ifilela lrh - |Click to add notes [
HEOET 4 | » |-

JD[anIEG;|AgtDShapESv “T kY DG‘|&'£'£'E_ =B ev
B O & & a0 & E L BIEAREIFE A A7 F A
| Outline | Default Design r@i.f_ o

6.4. Teksto Zyméjimas arba numeravimas specialiaisiais simboliais

Teksto eilutes, kuriose yra irasyti laboratoriniy darby pavadinimai, pazymékite arba

sunumeruokite pasirinktais specialiaisiais simboliais.

Jei skaidrés pasirinktoje formoje yra numatyti teksto zymejimo arba numeravimo specialieji
simboliai, tai jie atsiranda automatiskai. Jei skaidrés formoje to néra, kaip Siuo atveju, tada suzymeti

galima dviem bidais: T=r=]
o Mygtukais ,
o Meniu Format/Bullets and Numbering pateikia dialogo langa:

Bullets and Humbering ﬂm
Bullsted INumbered I

- n
Mone - o -
- [w] [ ]
a < b v
a o > v
a o > v

SieE) IIDD E e et bk Enlhr I_ "I Picture... | Character. .. |

K I Cancel |
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Dialogo lango funkcijos tos pacios, kaip ir tekstinio procesoriaus. Pasirinkite jums patikusi
specialyji simboli. Prisiminkite, kad galite parinkti simbolio spalva, garsa ir animacija.

6.5. Paveiksléliy jkélimas

Ikelti paveikslélius galima vienu i8 biidy:

o Mygtuku Insert Clip Art Drawing mygtuky juostoje. m
o Meniu Insert/Picture/Clip Art atveria dialogo langa, kuriame : {vairiose
paveiksléliy kategorijose pateikiama gausybé paveiksléliy. Parinkite

patikusi ir ikelkite i skaidrg. Skaidrés srityje paveiksléli pazymékite ir valdykite —
perkelkite, didinkite, mazinkite — iprastu Microsoft Windows 2000 aplinkai budu.

1
Jei pasirenkama skaidrés forma, kurioje nurodyta vieta paveiksléliui, tada spusteléjus du

kartus simbolini paveiksléli, esanti skaidrés srityje, atveriama Microsoft paveiksléliy
galerija, kur jprastu budu parenkamas paveikslélis.

Norint idéti nuotrauka ar paveikslélj, esantj kompiuterio atmintyje bet kurioje vietoje, reikia
vykdyti komanda Insert/Picture-> From File ir atsivérusiame dialogo lange nurodyti reikiama faila,
kurj norite jdéti i skaidre.

6.6. Antrasciy jvedimas

Patogu kiekviena skaidr¢ papildyti informacija, kuri pateikiama antraStése, esanciose
skaidrés apacioje ir virSuje. Svarbu, kad skaidr¢je buty data ir skaidriy numeravimas, antrastés,
pastaba. [veskite savo rengiamo praneSimo antrast¢ skaidrés apacioje — PraneSimas apie
Informatikos laboratorinius darbus, prane$imo kiirimo ir atnaujinimo data ir skaidriy numerius $iuo
bidu:

o meniu View/Header and Footer atveriamas dialogo langas:

Header and Footer EHE |

Slide I Motes and Handouts I

—Include on slide &pply ko &l

¥ Date and kime

ald

= Update automatically Bpply
| 110103 =l Cancel
Language; Zalend ar Y pe;
IEninsh (L j I'-.-'-.-'estern j
" Fixed

Preview

v slide number
v Fooker

I.ﬁ.E informacijos centras

[ Dor't show on title slide
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Korteliu Slide ir Notes and Handouts srityse ijvedami antras¢iy parametrai.
Slide srityje Include on slide:

+ Date and time — paZymima, kad biity jvesta data ir laikas,

+ Slide Number — numeruojamos skaidreés,

+ Footer — ivedamas paantrastés tekstas.

Notes and Handouts — pasirinkus $ia kortelg, pasirodo naujas dialogo langas, kuriame
papildomai galima ivesti antrast¢ Header, data pasirinkta kalba ir skaidriy numerius, kai norima,
kad jos biity spausdinamos viename puslapyje.

6.7. Teksto jvedimas pastaby srityje

PraneSimo metu praneséjui patogu naudotis papildoma informacija, kuri primena
svarbiausius praneSimo akcentus. Tokia informacija paranku ivesti | skaidrés pastaby sriti.
Spusteléjus esama teksta Click to add notes, atsiranda Zymeklis. Tada ir jvedama reikiama
informacija. Kiekvienai rengiamai skaidrei jveskite po viena aktualia tai skaidrei pastaba.

6.8. Valdymo mygtuky jvedimas

Pristatymo metu dazniausiai nuo skaidrés prie skaidrés pereinama pelés spusteléjimu.
Taciau toks per¢jimo biidas néra patogus, nes gana daznai skaidres tenka rodyti ne eilés tvarka.
Tada patogu ivesti skaidriy rodymo valdymo mygtukus. [veskite keleta pasirinkty mygtuky. [vesti
valdymo mygtukai jvedami $iuo budu:

Meniu Slide Show/Action Buttons iSkviecia mygtuky rinkini, T
kuriame iésirinkgs mygtuka, pelés Zymeklis virsta + Zenklu ar TSide Show Window telp
ketgrguba rodykléle. ‘ E3 view show s D= E
Pasirinktas mygtukas pele-pliusu-keturguba rodyklele BT
nutraukiamas | norima vieta skaidrés srityje ir spusteléjus
atleidziamas. Atleidus pelés mygtuka atveriamas dialogo langas G ction uttons
Action Settings, kuris ir véliau visada gali bati atveriamas ! reset animation =l
spusteléjus jau sukurta mygtuka skaidrés srityje: # custom animation... 1| P ﬂ
Sl Transtien. v o4

[ online Broadcast [ . =
T - = A &

Set Up Show. .,

) Cuskarn Shows, .
Maouse Click, | Mouse Orer | .

3 ¥

—#ction an click,
" Mone
' Hyperlink to:

& Bun program:

I Efeise.. |

= Hu TG

| [
| Ghjest ackion;
| I~
[ Play sound:
I[No Sound] j
I | ittt elick
oK I Cancel |

Dialogo lango kortelés Mouse Click srityje Action o click pateikiamas valdymo mygtuko galimybiy
sgrasas:

e None- nenaudojami valdymo mygtukai,

o Hyperlink to: - rySys su skaidrémis, Interneto WWW ar kitais kompiuteryje esanciais

dokumentais,

® Run program:- programos vykdymas,

e Run macro:- vykdyti iraSyta makrokomanda,

e Object action: - jei praneSime yra ikelti ir susieti objektai (OLE), juos galima aktyvynti.
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e Play sound: - mygtuka lydés garsas, kurj galite taip pat pasirinkti, spustel¢j¢ pele laukelyje
esancia rodykle.

e Highlight click:- mygtuko paspaudima lydés animacija.

Pasirinkite valdymo mygtukui galimybg Hyperlink to:. Spusteléjus laukelio gale esancia

rodyklele atveriamos valdymo mygtuko funkcijos, 1§ kuriy parinkite reikiamas:

Action Settings EHE |

Mouse Click | Mouse Crver I

—fAckion an click
. MNane

* Hyperlink ko

Next Slide =]

; =
Previous Slide
First Slide
Last Slide
= |Last Slide Viewed
End Show
Cuskorm Show, .

Slide. ..
e URL...
COther PowerPaink Presentation. ..
Qther File. ..

™ Play sound:
|[N|:| Sound] j
I# | Highlighit click

Ok I Zancel |

Parinkus norimus parametrus dialogo lange Action Settings, paspausti mygtuka OK ir
valdymo mygtukas jkeliamas i skaidrg¢ nurodytoje vietoje.
Kortel¢je Mouse Over parenkami parametrai, kada naudojama pelé.

6.9. PraneSimo susiejimas su WWW dokumentais

Ivedus valdymo mygtuka, galima pristatyma susieti su savo sukurtu asmeniniu puslapiu.

Meniu Slide Show/Action Buttons. 1ssirinkite mygtuka Home ir padékite 1 norima vieta.
Action Settings spustelekite Hyperlink To. Parinkite tipa URL. Dialogo lange Hyperlink To
laukelyje URL iraSykite savo sukurto asmeninio puslapio adresa (Http://.......):

Mouse Click I Mouse Cver |

—Action an click.

" None
* Hypetlink to:

| =l
i Hyperlink To URL [Z]x]

LRL:
| M
cecs |

I I
™ Play sound:

|[N0 Sound] LI
| | Hiahligh click

OK | Cancel |

6.10. Prezentacijos redagavimas

Skaidre skirstoma { atskirus objektus, kurie yra modifikuojami. Redagavimo tvarka:
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1. Pereinama prie reikiamo objekto spragteléjus i ji pele.

2. Redaguojamas objektas zymimas spragtel¢jus pele du kartus.

3. Objektas perneSamas i norima vieta taip, kaip bet kuris kitas Windows programy objektas
- pele arba klaviSais.

4. Objekto dydis keiciamas kaip bet kurio kito Windows programuy objekto - pele.

Visi kiti redagavimo veiksmai atliekami vykdant meniu komandas ir/arba naudojant irankiy
juostu mygtukus.

7. Antros ir kity praneSimo skaidriy kiirimas.

o Mygtuku h:fEl

o Meniu Insert/New Slide,

o Maketo srityje po skaidrés pavadinimu spusteléjg pele.

Parinkite skaidrés tipa ir forma:

Vykdyti Format/Apply Design Template ir Format/ Slide Layout.
Tolesni objekty formavima organizuoti, priklausomai nuo struktiiros.

8. Skaidrés fono keitimas

Format-> Bacground >

Fill Effects. Atsivérusiame lange:
el B ||

Background Fill Effects [2]x]
. 4 Fill Gradient | Texture I Pattern I Picture I
Backareund Aol o Al o]
Color X
Color 1;
= o — |
cancel |  Two colors
- Preset ﬂ J j

Erevien

~Shading stvle:

" Horizontal

1 : " Yertical
r |||:| Aukomatic | master  Diaganal up
" Diagonal down
. I:‘ . D . . D " From corner
M o  From litle
Wore Colors, ..
IR et

Gradient- pasirinkti spalvinj pagrinda:

One Color — vienspalvis;

Two colors — dvispalvis pagrindas;

Preset — pasirinkti spalvini derinj .

Galima pasirinkti daugiaspalvio pagrindo peréjimo efektus (Shading styles):
Horizontal — horizontalus spalvinis peréjimas;

Vertical — vertybiniy popieriy vertikalus spalvinis peréjimas;

Diagonal up — [striZinis i§ virSaus per¢jimas;

From Corner — spalvinis derinys iSsidésto i skaidrés kampo;

From title — skaidrés spalvos iSsidésto ketvirciais i$ skaidrés vidurio;
Kortel¢je Texture — parinkti skaidrei medziaginj pagrinda.

Kortel¢je Pattern — parinkti skaidrei rasta.

Kortel¢je Picture — parinkti skaidrei paveiksléli (per Browse), kuris bus skaidrés fonas, t.y. per
visg skaidre.

Sample:

9. Pristatymo iSsaugojimas

File>Save As. Atsivérusiame lange:
o I3skleidziamame sarase Look _in parinkti laikmena (diska), kur reikia iSsaugoti faila;
e Naujame sarase Save_in parinkti kataloga, kuriame reikia uzregistruoti iraSoma faila;
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o Spragteléti pele laukelyje File Name ir irasyti norimo iSsaugoti failo varda, pvz., AE
Informacinis centras;

e SaraSe Save as type parinkti falo plétinj (tipa) Presentation (*.ppt);

e Paspausti mygtuka Save.

10. Animacijos suteikimas skaidriy objektams

Animacija gali buti suteikiama ir tekstui, ir objektams, ir valdymo mygtukams, t.y visiems
skaidrés objektams. Animacija kuriama rezime Normal View. Pirmiausia paZymimas objektas, kur
norima animuoti. Tada meniu Slide show-> Custom Animation atveriamas dialogo langas:

Custom Animation K E |
Check to animate slide abjects; I
eck to animate slide objects Informacijos centre QK

Cancel |
Preview |

[ Title 1

Eusy Lk bhm makoly:
wm nskhn makcLy,

[~ &ction bukton: Forward or next 3
[~ Picture frame ¢

Order & Timing |EFFeu:ts I Chart Effects I Multimedia Settings |

Animation order: —Skart animation

1. Title 1 % on mouse click

4 | " utomatically,
Maove I g
¥+ | seconds after previous

event

Animacija suteikti galite ir skaidrés pavadinimui, ir norimai teksto daliai, ir valdymo
mygtukams, ir paveiksléliams. Animacija turi biti saikinga, kad padéty aiskiai perteikti pristatyma.
Kiekviena objekta reikia zymeéti atskirai ir parinkite skirtinga animacijos biida. Laukelyje Check to

animate _+ | slide objekts pazymékite norimus animuoti objektus. Korteleje Order &
Timing MLI rodyklélémis nurodykite animuojamy objekty pasirodymo skaidréje
eiliSkuma.

Laukelyje Start animation rekia nurodyti, ar objektas pasirodys nuo pelés paspaudimo, ar
automatiskai po kito objekto, parenkant laiko tarpa arba be uzdelsimo.

Korteléje Effects parinkite konkrety animacijos biida, pavyzdziui, skaidrés pavadinimui —
Fly, tekstui —Blinds, valdymo mygtukui — Spiral ir t.t. Kortelé Chart Effects skirta diagramoms
animuoti.

N . . . . . . . . Preview
Perziiiréti kaip bus pristatomi animuoti objektai, galima paspaudus mygtuka —l

11. Skaidriy paruoSimas demonstravimui, pristatymo efekty pasirinkimas

Slide Show—> View show — skaidriy perziiira;

Slide Show—> Rehearse Timings — nustatyti skaidrés demonstravimo laika. (Jei laikas nenustatytas,
pereiti prie kitos skiadrés bus galima su pelés spragteléjimu.);

Slide Show—>Record Narration — [garsinti skaidrg i$ jau turimo failo pasirinktinai (Browse) arba
per mikrofona.

Slide Show~> Slide Transition| - parinkti skaidréms (arba kiekvienai skaidrei) skirtingus peré¢jimo
efektus;
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Slide Show—>Preset Animation — nustatyti jvairius demonstravimo efektus skaidriy tekstinéms,
grafinéms bei kitoms dalims. Po to reikia perzitiréti pristatyma.

12. Parengto praneSimo demonstravimas.

Tai atliekama vienu i$ budy:
o Mygtukais Slide Show = arba Slide View, , &7 esanciais skaidrés
apacioje, parodoma pirmoji praneSimo skaidre,
o kita arba ankstesné skaidré rodoma pelés spustel¢jimu arba klavisais Page Down ir Page Up,
o kontekstinis meniu, kuris atveriamas rezimu Slide Show; spusteléjus desinjji pelés mygtuka,
iSkvie¢iamos komandos:Go—> By Title> AE Informacinis centras, ir t.t.
Next — kita skaidré,
Previous — ankstesné skaidré,
Go/By Title — galima rinkti skaidres pagal pavadinimus,
Meeting Minder — rodo pastabas, galima tvarkyti laika,
Speaker notes — leidZia perziiréti skaidrés pastabas,
Pointer Options — galima parinkti pelés zymeklio forma, spalva, rodykle, plunksna;
End Show — grizti 1 busena Normal View.
oo
Suteikiama galimybé perzitiréti visas skaidres i$ karto — Slide Sorter ==
Siame rezime galima keisti skaidres vietomis, naikinti, paslépti.

13. Skaidriy paslépimas ir atSaukimas

Kai parengiama daugiau skaidriy, negu norima rodyti, tai praneSimo metu tos skaidrés,
kurios nebus rodomos, paslepiamos:
o Slide Show/Hide Slide — paslepiama skaidré, kuri rezimu Slide Sorter bus rodoma perbraukta,
o Slide Show dar karta spusteléjus Hide Slide, skaidrés paslépimas atSaukiamas.

14. Skaidriy spausdinimas

Meniu File-> Print atveriamas dialoginis langas:

Print HE
— Prinker
Marme: ICanu:un 5100 j Properties |
Status: Idle
Type: Canon 5100
Where: IISEPRMOL
Carnrnenk: ™ Prink ko File
— Prink range —iCopies
o al " Current slide € Seleckion Mumber of copies:

=]

£ ) Guistom Show I j

T
 slides: |

Enter slide numbers andfor slide ranges. For example,

1;3;5-12 ¥ Callate
Print what: Handouks
Handouts ﬂ Slides per page: IE- vl I
Slides 4]
Order: % Horizonkal © Wertical Cel

Makes Pages
Cutline Wiew
Grayscale [ Scale ko fit paper

[ Pure black and white ¥ Frame slides

I | Iniclude animations = | Erint hiddem slides QK I Cancel |
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1) Nustatomi skaidriy parametrai Print what :

o Slides — spausdinti kiekviena skaidr¢ atskirame lape;

o Handouts, -spausdinti po kelias skaidres viename lape Slides per page — 6 (pasirinkti
kiek skaidriy viename lape);

o Notes Pages — pastaby lapai;

o Outline View — spausdinamas tik tekstinis skaidrés turinys.

2) Pure Black and White — nustatomas juodai baltas spausdinimo rezimas: balta spalva visiems
uzpildytiems objektams, juoda spalva tekstui ir linijoms, objektai apréminami, spalvoti pieSinukai
spausdinami pilko atspalvio.

15. Irankiy juosty mygtukai

Pagrindiniai jrankiai (Standart)

Mygtukas | Pavadinimas Paskirtis

5 Insert New Slide Sukuriama nauja skaidré pagal nauja pavyzdi i§ AutoLayout
— meniu

i Insert Graph Sukurti diagrama

@ Insert ClipArt [terpti piesini i§ ClipArt archyvo

Apply design Modifikuoti skaidrés stiliy pagal pasirinkta Sablona.

& Slide Layout Pritaikyti prezentacijai tam tikra dizaing pagal Zynio pateiktus

sitilymus
ﬁ Insert MS Word [terpti MS Word lentelg
table

PieSimo jrankiai (Drawing)
Mygtukas | Pavadinimas Paskirtis

Draw = Draw Priemoniy rinkinys, skirtas grafiniy objekty grupavimui,

rany - | y g jekty  grup

' vaizdavimo eiliSkumui nustatyti.
IE Select Objects Pazymeti teksta ar grafini objekta

A Text Box Iterpti teksto laukelj

. Line Braizoma linija

] Rectangle Bréziamas staciakampis

- Oval Bréziama elipsé

—, Arc Tool Bréziamas lankas

“u Arrow Braizyti rodykle

¢ Free Rotate Pazyméto objekto sukimas norimu kampu apie nurodyta taska
furnShapes AutoShapes Pateikiamas jvairiy figiiry sarasas

1l Color zplldo, pakeiCia pazymeta objekta norima spalva, rastu ar
Fill Col Uzpildo, pakeifia pazymé bjek i pal S

- faktiira

ER; Line Color Keicia linijos spalva

m Shadow Suteikia/Salina objektui Sesélp

S Line Style Linijy storio koregavimas

= Arrow Style Rodykliy (stréliy) tipo parinkimas
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= Dashed Lines Linijy tipai. Gali biiti priskiriama tik pazymétiems objektams.

iy 3-D Suteikti objektui triju matavimy (erdvinj ) efekta

Teksto tvarkymo jrankiai

Mygtukas Pavadinimas Paskirtis
A Increase Font Size | Pazymétas tekstas padidinamas kartotiniu dydziu
AT Decrease Font Size | Pazymétas tekstas sumazinamas kartotiniu dydziu
@ Text Shadow Tekstui priskiriamas Sesélis
= Increase Paragraph | Didina tarpus tarp pastraipos eiluciy
Spacing
= Decrease ' Mazina tarpus tarp pastraipos eiluciy
Paragraph Spacing
& Promote (Indent Atlieka teksto pastimima i kairg
' less)
o Promote (Indent Atlieka teksto pastimima i deSing
more)

Animacijos nustatymo jrankiai

Mygtukas Pavadinimas Paskirtis
Animate Title Sukurti judry skaidrés pavadinimo pasirodyma.
Animate Slide text Pagyvinti skaidres turinio teksto pasirodyma.
A Drive-In Effect Sukurti objekto pasirodyma i§ deSinés i kairg.
s Flying Effect Sukurti objekto pasirodyma i§ kairés 1 deSing.
o Camera Effect Palaipsninis objekto atsiradimas, jam did¢jant
% Flash Effect Demonstracijos metu objektas pasirodo, o
pradéjus vaizduoti kita objekta, vel iSnyksta.
%% Custom anomation Priemoniy rinkinys, padedantis vartotojui
sukurti nestandarting animacija.

16. PowerPoint meniu

16.1. File

New -iskviecia dialogo langa naujai prezentacijai sukurti.

Open -ikelia jau sukurta prezentacija.

Close -uzdaro aktyvia prezentacija.

Save - iSsaugo aktyvia prezentacija.

Save As - iSsaugo aktyvia prezentacija, suteikiant jai bylos varda.

Find File -PowerPoint programos kuriamy faily paieska, kai nezinoma tikroji ju buvimo vieta.
Summary Info -informacija apie prezentacija.

Slide Setup -Prezentacija sudaroma i§ skaidriy rinkinio. Su §ia komanda nustatomi skaidriy
iSmatavimai bei lapo orientacija.

Print -skaidriy spausdinimas.
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16.2 Edit

Undo -atSaukti paskuting ivykdyta komanda.

Cut -iskirpti pazyméta objekta.

Copy - kopijuoti paZzymeéta objekta i laikinos atminties bufer;.

Paste -jterpti iSkirptus(nukopijuotus) objektus islaikinos atminties buferio.
Clear -3alinti paZyméta objekta.

Select All -pazyméti visus objektus.

Dublicate -padaryti objekto kopija, nesikreipiant i laikinos atminties buferi.
Delete Slide -naikinti skaidre.

Find -surasti zodi ar simboliy seka skaidréje.

Replace -surasta zodi keicia kitu.

Edit Object -paZyméto objekto redagavimas.

16.3. View

Slide Show -demonstruoja sukurta prezentacija.
Toolbars -dialogo lange pasirenkami jrankiy meniu.
Ruler -rodo/slepia liniuotg.

Guides -uZzdeda darbo lange pagalbines linijas.
Zoom -padidina/sumazina skaidre.

16.4. Insert

New Slide -iterpia nauja skaidre.

Date -iterpia data.

Time -jterpia laika.

Page Number -jterpia puslapio numer;j.

Slides from File.. .-iterpia skaidres i$ kitos bylos.

Slides from Outline.. .- jterpia skaidres, sukurtas kitoje programoje.
ClipArt...-atidaro pieSiniy bibliotekos langa.

Picture -jterpia pieSini.

Microsoft Word table...-iterpia Ms Word lentelg.

Microsoft Graph -jterpia diagrama.

Object...-iterpia objekta, kuris sukuriamas kitoje programoje.

16.5. Format

Font -teksto Srifto parinkimas.

Alignment -objekto ar teksto iSdéstymas skaidréje.

Center -centre, Right -desin¢je, Justufy -pagal abu krastus.
Line spacing -nustatomas tarpas tarp pastraipos linijy.

Change Case...-pazyméto teksto keitimas.

Colors and lines -nustatomos linijos ir ju spalvos.

Shadow -nustatomas Sesélis.

Pick up Style -pasirenkamas nurodyto teksto ar objekto stilius.
Apply to Defaults -priskirti pasirenkama stiliy tekstui ar objektui.
Presentation template -iSrenkamas prezentacijos Sablonas.
Slide Layout -skaidrés objekty bei teksto i§déstymo psrinkimas.
Slide Background -skaidrés fono parinkimas.

Slide Color Sheme -skaidrés spalvy nustatymas.

16.6. Tools
Spelling -reSybos klaidy tikrinimas tekste.



Replase Fonts -Srifty pakeitimas.

Transition -skaidriy keitimosi (prezentacijos metu) efekto, greicio bei garso parinkimas.
Build -teksto “skriejimo” pasirinkimas.

16.7. Draw

Group -sugrupuoti objektus.
Ungroup -iSgrupuoti objektus.
Regroup -pergrupuoti objektus.

Bring to Front -perkelti pazyméta objekta virs kity objekty.
Send to Back - perkelti pazyméta objekta po kitais objektais.
Align> -Zyméty objekty iSdéstymas: pagal kairjji objekta (Lefts), iScentruoti (Centers), pagal

desinjji objekta (Rights), pagal virSutini objekta (Tops), centre (Middles), pagal apatini objekta

(Bottoms).

17. Skaidriy kirimas MS PowerPoint programa: Zingsnis po Zingsnio

Startavus PowerPoint atsiveria langas, sitlantis pasirinkti naujos prezentacijos kiirimo
metodika. Tai sukurti galima keliais buidais:

PowerPoint

— Create a Mew Prezentation Using———

~ Blank Presentation

% {~ Open an Existing Presentation

Tip for

e (1
zers

The AutoContent

Wwizard iz the quickest

way to create a
presentation.

AutoConten Wizard - visiskai automatizuotas
prezentacijos kiirimas skirtas tiems, kurie dar
tik pradeda dirbti PowerPoint.

Template - prezentacijos kiirimas naudojantis
i§ anksto paruostu Sablonu pasirenkamu i§
programos pasiiilyto saraso.

Blank Presentetion - prezentacijos kiirimui
pateikiamas tuscias lapas.

Open an existing presentation - atidaroma
jau sukurta prezentacija.

1 Zingsnis. Naujam pristatymui kurti pasirenkame Blank Presentation.

2 Zingsnis. Pasirinkti skaidrés struktiira.

HNew Shde

=1

Choose an Autolayouk:

M ==

Cancel

il

[T Don't show this dialog box again

Title Slide

[rasyti teksta ar jterpti grafini objekta.

3 Zingsnis. Kurti nauja skaidre, spaudZiant mygtukqﬂ New Slide. Kartoti 2 Zingsni.
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Sukurti tiek skaidriy, kiek reikia.
4 Zingsnis. Uzdéti visoms skaidréms $abloninj fona. Format=> Apply Design Template.
5 Zingsnis. Pakeisti, jei reikia, skaidrei fona Format-> Background.
Background [ 2] =] | Uzdéti  varnele ant  opcijos  Omit

background graphics from master tam,
izl I ":‘"| kad nusiimty uzdétas standartinis fonas.

Title of Slide Aprly Spausti rodykle prie spalvos ir eiti | Fill
. Bullat text Effects. Norint parinkta fona nustatyti
- H:I] Cancel vienai skaidrei, spausti Apply. Norint, kad

naujas fonas blity nustatytas visoms
S skaidréms, spausti Apply to All.

—Backaraund Fill

Wik

! |

v omit background graphics From masker:

6 Zingsnis. Pristatymo perziiiréjimo rezimai:

o 5 Slide Show - ReZimas,
— =) skirtas skaidriy

‘/‘/J];_ p— demonstarvimui
1 Normal View 2 Outline View — 3 Slide View — 4 Slide Sorter View —
— rezimas, rezimas, skirtas rezimas, skirtas rezimas, skirtas
skirtas skaidriy skaidriy redagavimui skaidriy skaidriy eilés tvarkos
redagavimui kompozicijos keitimui

redagavimui

7 Zingsnis. Pristatymo skaidriy transportavimo nustatymas:

[jungti rezima 4 Slide Sorter View, spausti mugtuka Slide Transition - , pasirinkti skaidriy
pakeitimo rezima.

Patartina papildomai pasirinkti opcija On Mouse Click, kad skaidrés keistysi nuo pelés
paspaudimo.

8 Zingsnis. Nustatyti skaidrése animacinius efektus.

[jungti rezima 1 Normal View arba 3 Slide View.

Komanda Slide Show = Custom Animation. Pasirinkti objekty animaciniy efekty parametrus.
Patartina papildomai pasirinkti opcija Automatically, kad skaidrése pirmas objektas pasirodyty i$
karto, o kiti gali ir On Mouse Click - nuo pelés paspaudimo, jei apie juos nemazai kalbate.

9 Zingsnis. Pademonstruokite sau pristatyma, jjungiant 5 Slide Show rezima. Nutraukti
demonstravima — klavisas Esc. Jei norite grizti pazitiréti pries tai rodytos skaidrés, spausti rodyklini
klavisa i virSy arba i kairg. Sekancia skaidre galite perzitiréti paspaudg klavisa 1 apacia arba i deSing,
taip pat spaudziant pelés kairiji klavisa.

10 Zingsnis. Istaisykite klaidas, peréje i kita perzitir€jimo rezima.
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UAB “Baltic Logistic System
Vilnius”

Pazintis su imone ir teikiamomis
paslaugomis

BIZPAK PADALINIU STRUKTURA

Pristatymo pavyzdys

Svedijos Karaliskasis Pastas pradéjo savo veikla
Li s
UAB “Baltic Logistic System Vilnius” -
dukteriné $io pasto imoné, teikianti smulkiy

siunty pristatymo paslaugas.

Kas yra Bizpak?

1 Priedas

BLStinkles

Esame tarptautinio tinklo dalis, kitos BLS grupés
imonés jsikiirusios:

v Rygoje - “BLS — Latvija”,

Taline - “BLS Eesti”,

¥ Var$uvoje - “Masterlink Express”,

vSankt Petetburge, Maskvoje, Niznij Novgorode bei
Voroneze - “Armadillo Business Parcel”.

Uzsakymo vykdymo terminai

VILNIAUS
CENTRINIS
BIURAS

Kauno Panevezio | | Klaipedos Siauliu
regionio regiono regiono regiono
padalinys | | padalinys | | padalinys | | padalinys
Pervezty siunty ir kroviniy
per 2000m kiekis tiikst. vrt.

Bizpak paslaugos populiarumas
tarp Lietuvos jmoniy
aug.

Rekordinis Bizpak siunty
= Kiekis pasicktas 2000 m TIT
w ketvirtyje
m
"

Thetv, 2here. Iherv. ke

Bizpak— tai smulki siunta nuo laisko iki 35 kg svorio.
Tai ne kurjeriné paslauga.

Tai siuntos pristatymas “nuo dury iki dury” per 24 val. pagal

schema “verslas verslui”,

Garantuotas pristatymas ne véliau kaip

iki kitos darbo dienos 16.00 val. q

Patikékite mums savo rapescius
ir galésite miegoti ramiai !
Tai operatyvu, patikima, Siuolaikiska ir efektyvu.
Naudokités Bizpak siunty pristatymo
paslauga !

I zona II zona III zona
Uzsakymo iki 14.30 val. iki 11.00 val. iki 11.00 val.
priémimas

Siuntos iki 17.00 val. iki 15.00 val. iki 15.00 val.
paémimas

Siuntos iki kitos darbo iki kitos darbo iki kitos darbo
pristatymas | dienos 14.00 val. [ dienos 14.00 val. [ dienos 16.00 val.




Uzduotis:

2 Priedas

Sukurti pristatyma su MS PowerPoint laisva tema (savo veiklos, laisvalaikio ar pasirinktos jmonés

kt.)
Reikalavimai:
1. Skaidriy skaicius: 8-12.
2. Teksto Sriftas ne mazesnis kaip 18 pt.
3. Skaidrése turi biiti panaudota bent po 1:
e lentele,
e paveiksleli 1§ Internet’o,
e diagrama,
e struktiiring (bloking) schema.
4. Panaudoti skaidriy pateikimo animacinius efektus.
5. Panaudoti skaidriy viduje kai kuriems objektams animacinius efektus.

Mokeéti komentuojant pademonstruoti.
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